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Index 
 

A 
abbreviations, 46 
about BSD CostLink/AE 

command in help menu, 127 
ADD, 59 
adding commands, 96 
adding costs 

user-defined, 67 
adjustments, 67 
Adobe Acrobat format 

export reports to, 81 
aecLinkMan, 111 
arrange icons 

command on window menu, 126 
arranging windows. See windows 
ASM, 59 
assemblies, 64 

about estimating with, 8 
example, 64 
identifying members of, 61 
item form, 58, 65 

Assemblies 
resource window. See resource windows 

auto-recalculate markups 
command on tools menu, 125 

B 
base cost, 57, 60 
blue icon on folders or tasks, 40 
building perimeter, 54 
building size, 54 

C 
calculator 

open from Tools menu, 98 
cascade windows 

command on window menu, 126 
change Excel links source, 125 
change RS Means database 

command on tools menu, 126 
chapter summary 

user manual, vii 
child folder 

command on insert menu, 125 
close 

button on toolbar, 118 
command in file menu, 121 

compact 
command on file menu, 92 

compact database 
command in file menu, 121 

company logo 
insert on reports, 72, 81 

construction priced from R.S. Means, 68 
contents 

command in help menu, 127 
context menus, 127 
contingencies 

about the RS Means cost data, 7 
contractor fees, 70 

how calculated, 70 
copy 

button on toolbar, 119 
command in edit menu, 122 
command in file menu, 121 
how to copy projects, 90 

copy and paste 
how to, 64 

cost 
cost to owner, 60 
cost to prime, 60 
project cost, 61 

Cost Estimate 
without models, 18 

cost estimates, no model, 18 
cost model additives, applying, 15 
cost summary tab 

summary information dialog box, 67 
tips, 68 

cost to owner, 57 
cost to prime, 57 
CostLink/AE 

adding costs, 22 
adding folders, 20 
applying markups, 16 
creating model project file, 12 
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overview, 2 
printing reports, 33 
project notes, 19 
tools and techniques, 84 

costs. See also RS Means Cost Data 
abbreviations list, 129 
adding lump sum quote, 67 
adding to estimate, 61 
adjustments, 67 
base cost, 57 
change reference database, 99 
changing, 60 
copying into projects, 63 
cost to owner, 57 
cost to prime, 57 
fees, 67 
markups, 67 
per unit cost for folders, 57 
per unit cost for project, 51 
project cost, 58 
show in reports, 74 
show in tree panel, 42 
updating, 98 
viewing on tasks, 58 

costs, adding, 22 
create a new project 

button on toolbar, 118 
creating a project, 49 
creating an estimate, 49 
CSI MasterFormat and UniFormat, 49 
custom reports, 77 
customize tools menu, 96 

command on tools menu, 126 
customizing display, 38 
customizing toolbars, 94 
cut 

button on toolbar, 118 
command in edit menu, 122 

D 
database windows, 38 
delete 

button on toolbar, 119 
command in edit menu, 122 

delete empty folders, 90 
command on tools menu, 126 

delete link from source 
command in LinkMan menu, 125 

detail estimate report, 80 
detailed estimate, 74 
direct costs 

adding to estimate, 61 
disable updating from sources 

command on LinkMan menu, 125 
down one level 

command in tree menu, 123 
drag & drop confirmation, 126 
drag and drop, 89 

how to, 63 
left mouse button vs. right, 89 
turn off confirmation prompt, 89 

drill-down tabs 
in print preview, 79 

E 
edit menu, 122 
effective pricing date, 51 
electronic copies of reports 

creating, 81 
emailing estimates, 81 
equipment costs 

about the RS Means cost data, 5 
escalation 

about the RS Means cost data, 7 
escalation index date, 51 
estimate. See also projects 

creating, 49 
date of, 51 
opening, 48 

estimated construction time, 51 
estimates 

emailing, 81 
estimating 

checklist, 7 
Excel. See linking to Excel 
exit 

command in file menu, 122 
expand all 

command in tree menu, 124 
expand branch 

button on toolbar, 120 
command in tree menu, 124 

export 
reports, 81 

exterior closure and framing, 54 

F 
fees, 67 

contractor, 70 
file menu, 121 
file name and path, 51 
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file size 
compacting, 92 

find 
button on toolbar, 118 
command in edit menu, 123 
how to use, 84 

folder 
command on insert menu, 124 

folder icon, 40 
folder tags 

show in tree panel, 42 
folders, 56 

buttons on, 58 
how to copy or move, 88 
item form, 57 
opening item form, 56 
printing options, 75 
tags, 57 

folders, adding, 20 
footer 

on reports, 76 
formatting reports, 75 

G 
general conditions 

about the RS Means cost data, 5 
general tab 

project folder form, 57 
Summary Info dialog box, 14 
summary information dialog box, 50 

go to folder 
command in tree menu, 124 

green icon on folders or tasks, 40 
green square Excel icon, 102 

H 
help 

contents tab, 44 
index, 127 
index tab, 45 
printing, 45 
search, 127 
search tab, 46 
searching, 45, 46 

help menu, 127 
cut, 88 
paste, 88 

I 
icons 

list of and descriptions, 40 
index tab, 127 

help dialog box, 45 
insert menu, 124 
installation instructions 

where to find, vii 

L 
labor costs 

about the RS Means cost data, 5 
launching other programs, 96 
line items, 66 

adding your own, 67 
item form, 58 

linking 
change Excel links source, 115 
delete link from source, 114 
disable updating from sources, 115 
parent quantity, 103 
paste link from source, 114 
refresh all links from sources, 114 
remove all links from sources, 115 

linking to Excel 
Excel comments, 111 
Excel features used, 111 
Excel icon on folders and tasks, 40 
overview of steps, 112 
parameter workbook characteristics, 110 
range names, 111 
setup, 105 
sheet names, 110 
software requirements, 104 
tips, 113 

LinkMan menu, 125 
load from compressed 

command in file menu, 121 
command on file menu, 93 

location adjustment 
about the RS Means cost data, 6 
Canada, 69 
how to enter, 69 

locking a form, 58 
logo 

insert on reports, 72, 81 

M 
markups, 67 
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markups, applying, 16 
MasterFormat, 49 
material costs 

about the RS Means cost data, 4 
MDL, 59 
Means Costs. See RS Means Cost Data 
menus, 120 

context, 127 
edit, 122 
file, 121 
help, 127 
insert, 124 
LinkMan, 125 
right-click, 127 
tools, 125 
tree, 123 
view, 123 
window, 126 

Microsoft Excel. See linking to Excel 
minus sign icon, 40 
model 

disconnecting from, 60 
model building parameters, 54 
model costs 

about the RS Means cost data, 4 
Model Estimate 

applying additives, 15 
cost models tab, 15 

model estimate, creating, 15 
model project file, creating, 12 
model workbooks. See linking to Excel 
models 

Uniformat II project template with models, 
53, 55 

move 
how to move folders and tasks, 88 

moving the software 
where to find instructions, vii 

N 
navigation, 41 
new project 

command in file menu, 121 
new window 

command on window menu, 126 
notes, 86 

blue icon on folders or tasks, 40 
printing on reports, 76, 87 
spell check, 53 
viewing, 87 

notes window 

command in view menu, 123 

O 
O&P 

about the RS Means cost data, 5 
open 

command in file menu, 121 
open assemblies resource window 

button on toolbar, 120 
open help to contents 

button on toolbar, 120 
open item form on the Sheet panel 

button on toolbar, 119 
open item form on the Tree panel 

button on toolbar, 119 
open recently used projects dialog 

button on toolbar, 118 
open the notes form 

button on toolbar, 119 
open the summary info dialog 

button on toolbar, 119 
open unit prices resource window 

button on toolbar, 120 
open windows list 

in window menu, 127 
opening a project, 48 
opening an estimate, 48 
organization name 

on reports, 73 
other costs, 70 
overhead and profit 

about the RS Means cost data, 5 
overtime 

about the RS Means cost data, 6 

P 
panels 

arranging, 38 
parameter workbooks. See linking to Excel 
parameters 

adjustable, 55 
model building, 54 

parameters, fixed, 54 
parent quantity 

linking to, 103 
paste 

button on toolbar, 119 
command in edit menu, 122 

paste link from source 
command on LinkMan menu, 125 
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pdf 
export reports to, 81 

permissions 
command in file menu, 122 

pictures, 86 
supported graphics file types, 87 
viewing, 87 

plus sign icon, 40 
preferences tab 

reports dialog box, 75 
preparation date, 51 
preview 

buttons in window, 79 
reports, 78 

print 
command in file menu, 121 

print percent of parent to level, 76 
print preview 

command in file menu, 121 
print selected report 

button on toolbar, 118 
print selected report to preview window 

button on toolbar, 118 
print setup 

command in file menu, 121 
productivity 

about the RS Means cost data, 6 
project 

delete empty folders, 90 
project cost, 58 
project description, 51 
project notes, 19 
project tasks. See tasks 
project title, 51 
projects, 48 

archiving, 93 
compacting, 92 
copying, 90 
cost models, 53 
cost models tab in summary information 

dialog box, 53 
creating, 49 
emailing to one who has CostLink/AE, 93 
model additives, 55 
model additives tab in summary information 

dialog box, 55 
notes, 52 
notes tab in summary information dialog box, 

52 
opening, 48 
saving and loading to compressed, 93 
summary information, 50 

prompt before completing drag 
command on tools menu, 126 

pull-down menus, 120 

Q 
qty 

quantity field, 102 
quantity 

options for entering or calculating, 102 
project folders, 57 
use formula value times, 60 
use MS Excel value times, 57, 60 
use parent quantity times, 57 
use paret quantity times, 60 
use quantity entered, 57, 60 

quotes 
adding as line item, 67 

R 
R.S. Means cost data 

abbreviations list, 129 
about annual updates, 98 
change R.S. Means database, 99 

recalculate all 
command on tools menu, 125 

recalculate the current project 
button on toolbar, 118 

recently opened databases 
listed in file menu, 122 

recently used dialog box, 48 
refresh all links from sources 

command in LinkMan menu, 125 
remove all links from Sources 

command on LinkMan menu, 125 
report setup 

command in file menu, 121 
reports, 72 

Acrobat format, 81 
add company logo, 72 
change project title, 51 
create pdf file from, 81 
creating electronic copies, 81 
custom, 77 
descriptions of, 80 
detail, 80 
detailed estimate, 74 
dialog box, 72 
drill-down tabs, 79 
exporting, 79, 81 
folder options, 75 
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footer, 76 
formatting, 75 
header, 74 
overview, 72 
previewing, 78 
print with or without markups, 74 
printing notes, 76, 87 
producing, 72 
selecting, 73 
summary, 74, 80 
table of contents, 74 
title page, 74 
unit cost column, 75 

reports, selecting and printing, 33 
resource windows, 62 

abbreviations on tasks, 129 
opening, 62 

right-click menus, 127 
RS Means abbreviations, 46 
RS Means cost data 

contacting RS Means, 8 
factors affecting costs, 5 

RS Means Cost Data 
explanation of costs, 3 

RSM, 59 

S 
sales tax 

how to enter, 69 
save as 

copy project instead, 90 
save to compressed 

command in file menu, 121 
command on file menu, 93 

search tab, 127 
help dialog box, 46 

searching 
using find, 84 

select all tasks 
command in edit menu, 123 

select and format reports 
button on toolbar, 118 

select model 
commercial, 54 
industrial, 54 
institutional, 54 
none, 54 

sheet items form 
command in view menu, 123 

sheet panel 
command in view menu, 123 

controlling display, 42 
icons, 41 
sorting data, 43 

show all folders 
button on toolbar, 120 

show data in tree 
command in tree menu, 124 

show folder data in tree 
button on toolbar, 120 

show folder tags, 42 
button on toolbar, 120 
command in tree menu, 124 

show hierarchy 
command in tree menu, 124 

single tab mode, 39 
software requirements 

for linking to Excel, 104 
sorting data 

in sheet panel, 43 
source tag, 59 
spell check 

project notes, 53 
stack windows in cascade 

button on toolbar, 120 
standard toolbar, 118 
status bar 

command in view menu, 123 
subscription 

includes annual updates of cost data, 98 
summary info 

command in file menu, 121 
Summary Info 

general tab, 14 
summary information dialog box, 50 

cost models tab, 53 
cost summary tab, 67 
model additives tab, 55 
project notes tab, 52 
Uniformat II project template with models, 

53, 55 
summary report, 80 
system requirements 

where to find, vii 
systems estimating. See assemblies 

T 
table of contents, 74 
tabs 

choosing single or multiple, 39 
tags 

on folders, 57 
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task 
command on insert menu, 125 

tasks 
abbreviations list, 129 
adding to estimate, 61 
assembly members, 61 
buttons on item form, 61 
copying into projects, 63 
how to copy or move, 88 
identifying if assembly or line item, 59 
item forms, 58 
opening item forms, 58 

templates, 49 
tile horizontally 

command on window menu, 126 
tile vertically 

command on window menu, 126 
tile windows horizontally 

button on toolbar, 120 
tile windows vertically 

button on toolbar, 120 
tiling windows. See windows 
title page, 74 
toolbar, 118 
toolbars 

command in view menu, 123 
customizing, 94 

tools menu, 125 
customizing, 96 

tree items form 
command in view menu, 123 

tree menu, 123 
tree panel 

command in view menu, 123 
controlling, 41 
icons, 40 
show folder tags, 42 
showing costs, 42 

U 
uniformat II, 8 
UniFormat II, 49 
unit cost 

column on reports, 75 
Unit Prices resource window. See resource 

windows 
UOM, 57 
up one level 

command in tree menu, 123 
update RS Means database 

command on tools menu, 126 
updating 

to new R.S. Means costs data, 98 
use formula value times, 102 
use MS Excel value times, 102 
use parent quantity times, 102 
use quantity entered, 102 
use single tab 

command in tree menu, 124 
use single tab for table 

button on toolbar, 119 
user manual 

chapter summary, vii 
send suggestions and corrections, viii 

USR, 59 

V 
view menu, 123 

W 
WBS, 49 
window menu, 126 
windows 

arranging, 38 
tiling, 38 
tips for using tile and cascade, 39 
working with multiple, 38 

with horizontal panels 
command in view menu, 123 
command in View menu, 38 

with vertical panels 
command in view menu, 123 
command in View menu, 38 
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